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PCIC3A - Computing Fundamentals

Unit 1 - Basic Skills

Operating System

Common Elements

Buttons and lcons

Windows

Menus

Text Boxes

Lists

Check Boxes and Radio Buttons
Dialog Boxes

Starting and Exiting Programs
Shut Down

Unit 2 - Computer Basics

Uses of Computers
Computer Characteristics
Types of Computers
Computing Devices
Computer Human Analogy
Hardware

Circuit Boards

Plugin Cards

Processor

Memory

Memory Types

Storage Devices

Input and Output Devices
Other Hardware

Adding New Hardware
Hardware Problems
What Is Software?
System Software
Application Software
Word Processing
Spreadsheets

Databases

PCIC3A - Computing Fundamentals

Teaches the skills and concepts required for the IC3 Computing
Fundamentals Exam

60 Lessons, 23 Exercises, 43 Reading Supplements, 10 Quizzes
and 3 Tests cover the following topics:

Logon

Control Panel

Date and Time

Display Options

Mouse and Keyboard Settings
Audio Volume Settings
Settings Problems

Software Installation

Installing Printers

Windows Help

Graphics

Presentations

Multimedia

Internet Programs

Utility Programs

Other Programs

Software Compatibility
Software Upgrades

Software Problems

Program Installation Problems
Software Developments
Information Encoding

Memory and Storage Capacity
Processor Speed

Computer Performance

Data Flow and Processing
Information Transfer
Computer Networks

Large Computer Systems
Choosing a Computer
Protecting and Maintaining the Computer
Troubleshooting Computer Problems
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PCIC3A - Computing Fundamentals (continued...)

Unit 3 -

Files and Folders

The Computer’s Filing System
My Computer

View Types

Folders List

File Types

Creating and Saving Files
Opening and Modifying Files
Opening a File Using Its Icon
Starting a Program Using Its Icon
Printing Files

Internet Files

Properties

Organizing the Computer’s Contents
File Management

Shortcuts

Organizing the Desktop

Time Saving Tips

Finding Files and Folders

Crashes and Backup

File Maintenance

Common File Problems

PCIC3B - Key Applications
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PCIC3B- Key Applications

PCIC3B - Key Applications

Unit 1 -

Unit 2 -

Basic Word Processing

Getting Started
Entering Text
Editing Text

Saving Documents
Creating a New Document
Opening Documents
Viewing Documents
Formatting Text
Fonts

Alignment
Character Case
Utility Functions
Find and Replace

Intermediate Word Processing 1

Character and Line Spacing
Indenting Paragraphs
Bullets and Numbering
Tabs

Rulers

Page Breaks

Header and Footer

Page Numbers

Section Breakes

Footnotes

Teaches the skills and concepts required for the IC3 Key Applications Exam

[Ele 176 Lessons, 114 Exercises, 6 Reading Supplements,
19 Quizzes and 3 Tests cover the following topics:

Spelling and Grammar

Margins

Page Orientation and Paper Size
Printing

Time Saving Tips

Saving Files to a Floppy Diskette
Task Pane

Office Clipboard

Getting Help

Managing Print Jobs

Common Print Problems
Common File Problems

Endnotes

Pictures

Hyperlinks

Inserting Symbols

Superscript and Subscript
Displaying and Hiding Toolbars
Document Statistics

Document Outlines

Templates

Formatting Marks
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PCIC3B - Key Applications (continued...)

Unit 3 - Intermediate Word Processing 2

Text Borders and Shading Inserting and Deleting Table Rows and Columns

» Styles » Resizing Table Rows and Columns
e AutoText  Splitting and Merging Table Cells
e Thesaurus » Table Borders and Shading
* Themes » Table AutoFormat
» Graphics » Sorting Table Data
» Text Wrapping » Converting Text to a Table
» Drawing * Document Comments
 Creating Tables e Track Changes
» Selecting Table Rows and Columns
Unit 4 - Basic Spreadsheets
» Spreadsheets Overview e Fonts
» Getting Started » Alignments
* Entering Data * Number Formats
» Editing Data » Format Painter
» Formulas » Resizing Rows and Columns
e Functions * Printing
e Saving Workbooks e Task Pane
» Creating New Workbooks » Office Clipboard
» Opening Workbooks » Getting Help
» Formatting Cells
Unit 5 - Intermediate Spreadsheets 1

Auto Fill

Editing Data Efficiently

Inserting and Deleting Cells

Inserting and Deleting Rows and Columns
Data Fitting Errors

Spelling Checks

Find and Replace

Formulas Containing Multiple Operators

Commonly Used Functions
Inserting Functions in Formulas
Modifying Formulas and Functions
Copying Formulas and Functions
Formula and Function Errors
Organizing Worksheets
Templates

Unit 6 - Intermediate Spreadsheets 2

* Wrap Text » Header and Footer

» Data Orientation * Hiding Rows and Columns
» Borders » Sorting Data

» Backgrounds * Print Area

e Styles * Print Scaling

e AutoFormats * Printing Titles and Gridlines
» Clip Art  Creating Charts

» Drawing * Modifying Charts

Page Breaks

Interpreting Data and Charts
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PCIC3B - Key Applications (continued...)

Unit 7 - Basic Presentations

Getting Started

Entering Text in a Slide
Adding New Slides
Moving Between Slides
Editing a Slide's Text
Saving a Presentation
Creating a New Presentation
Opening a Presentation
Viewing a Presentation
Organizing Slides
Formatting a Presentation
Slide Backgrounds

Fonts

Unit 8 - Intermediate Presentations

Text Boxes

Tabs

Header & Footer
AutoCorrect

Spelling Check

Find & Replace
Formatting Placeholders
Inserting Clip Art
Inserting Pictures
Adding Drawings

")) Teknimedia 1C*

PCIC3C-Living Online

Unit 1 - The Internet

Computer Networks

Internet Overview

Uses of Computers and the Internet
Accessing the Internet

Internet Software

What You Need To Get Started
World Wide Web

Internet Addresses

Viewing Web Pages

Web Sites

Revisiting Web Pages
Favorites

Organizing Favorites
Searching the Web

Alignment

Bullets & Numbering
Format Painter
Adding Notes
Displaying a Slide Show
Saving a Slide Show
Print Setup

Print Preview
Printing

Task Pane

Office Clipboard
Getting Help

Modifying Drawings

Adding Tables

Adding Charts

Inserting Movies and Sounds
Changing Slide Layouts
Slide Master

Templates

Slide Transitions
AutoContent Wizard

PCIC3C - Living Online

PCIC3C - Living Online
Teaches the skills and concepts required for the IC3 Living Online Exam

38 Lessons, 19 Exercises, 23 Reading Supplements,
7 Quizzes and 3 Tests cover the following topics:

Evaluating Information on the Web
Internet Explorer Window
Saving Web Pages

Copying Web Page Elements
Printing Web Pages
Downloading Web Pages
Customizing Internet Explorer
Internet Security

Internet Options

Group Messaging Services
Computer Risks and Safety
Internet Safety and Rules
Using Computers Responsibly
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PCIC3C - Living Online (continued...)

Unit 2 - E-Mall

E-Mail Overview

Getting Started

Outlook Express Window
E-Mail Components

. Receiving Attachments
» Receiving and Viewing Messages

Embedded Information
Replying and Forwarding
Signatures

Marking Messages

Mail Management
E-Mail Options

Finding Messages
E-Mail Guidelines

E-Mail Problems

Composing and Sending Messages
Address Book

Using Your Contacts List

Group Lists

Sending Attachments

Delivery Options

Standalone

PCIC: is available for delivery on standalone computers. The courses can be accessed by
multiple students on the same computer. One Standalone License of PCIC? is required for
each computer. Standalone delivery of PCIC? provides the following benefits:

» Powerful Management Functions — PCIC? is delivered using the Virtual Learning Center
(VLC) management system which allows instructors to enroll learners, assign courses
to them and print their progress reports from each computer where PCIC? is installed.

» Comprehensive Records — VLC keeps comprehensive records of student activity and
presents the records for multiple students on one screen.

* No Damaged, Lost or Stolen CD’s — Courses are installed on the computer’s hard disk
so CDs are not needed after installation.

Network

PCIC: is available for delivery over a Local Area Network (LAN). The courses can be
installed on the network’s file server and accessed from any computer on the network. One
Network License is required for each file server where PCIC3 will be installed. Network
delivery of PCIC: provides the following benefits:

* Powerful Management Functions — Courses are delivered using the Virtual Learning
Center (VLC) management system which allows instructors to enroll learners, assign
courses to them and print their progress reports from any computer on the network.

» Comprehensive Records — VLC keeps comprehensive records of student activity and
presents the records for multiple students on one screen.

é i « Efficient Use of Computers — Learners can use any computer on the network to revisit
a course or access their records; they don’t have to return to the same computer each
AR T Y t| m e .

* No Damaged, Lost or Stolen CD’s — Courses are installed on the network file server’s
hard disk, so CD’s are not needed after installation.

* One System Back-Up — Course records are stored on the network file server, requiring
only one system backup.
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Delivery Options (continued...)

Internet

PCIC: is available for delivery over the Internet. The courses can be accessed from
Teknimedia's web site using any computer connected to the Internet. Internet delivery of
teknimedia.com PCIC: provides the following benefits:

* Anytime/Anywhere Access — Students can take courses and administrators can manage
student records any time, at home or work, from any computer connected to the Internet.

» Powerful Management Functions — Courses are delivered using the Web Learning
Center (WLC) management system which allows organizations to set up accounts, enroll
learners, assign courses to them and view their records.

e Comprehensive Records — WLC keeps comprehensive records of student activity and
presents the records for multiple students on one screen.

» Immediate Availability — Courses are available immediately when purchased with credit
card or using purchase orders on pre-approved accounts.

* No Installation Required — Courses reside on Teknimedia's web servers and do not
require installation on an organization’s file servers or computers.

* No Updates Required — Course updates will be reflected on Teknimedia’s web servers
and become available to all users immediately.

Teacher’s Guides and Student Study Guides

PCIC: courses include Teacher's Guides and Student Study Guides that are included on the Installation CD in
Adobe Acrobat 4.05 and MS-Word 2000 formats. These guides may also be downloaded from Teknimedia's
Web site at www.teknimedia.com. Each Teacher's Guide and Student Study Guide includes:

» Learning Objectives

» Course Table of Contents

» Mapping of PCIC3 to IC3 Objectives

e Text of Lessons and Reading Supplements
» Text of Frequently Asked Questions

» Course Quizzes and Tests

Other IC3 Resources

Teknimedia offers comprehensive resources for IC? including:

» Text books for use in instructor-led classes and blended training environments.

» Preparation tests to help learners assess their skills, build confidence and ensure readiness for the
IC3 exams.

» Vouchers for taking the IC® exams.

For more information, please go to www.teknimedia.com or call 1-800-366-4614.
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Minimum System Requirements

Standalone Delivery

» Multimedia PC with Sound Card

» Speakers or Headphones

 Pentium or Equivalent Processor

« Windows 98, NT 4.x, 2000, or XP Operating System

* 64 MB RAM Minimum, 128 MB Recommended

* 4X CD-ROM

« 16 Bit Colors, 640x480 Display

* Free Hard Disk Space: 50 MB for Management System and 300 MB for all 3 PCIC® Courses

Network Delivery

Network
e 10 Mbps (100 Mbps recommended for more than 10 simultaneous users)

Server

 Pentium Il Class Server or better

» 300 MHz (500 MHz or better recommended for more than 10 simultaneous users)

* 256 MB RAM (512 MB or more recommended for more than 10 simultaneous users)

* Free Hard Disk Space: 50 MB for Management Systemand 300 MB for all 3 PCIC? Courses

* Novell (v 4.x and above), Windows NT (v 4.x and above), Windows 2000, or Windows 2003
Server Software

Client

» Multimedia PC with Sound Card

» Speakers or Headphones

 Pentium or Equivalent Processor

« Windows 98, Me, NT, 2000, or XP Operating System
* 64 MB RAM Minimum, 128 MB Recommended

« 16 Bit Colors 640x480 Display

» 10 MB Free Hard Disk Space

Internet Delivery

Client

 Multimedia PC with Sound Card

» Speakers or Headphones

 Pentium or Equivalent Processor

* Windows 98, Me, NT, 2000, or XP Operating System
* 64 MB RAM Minimum, 128 MB Recommended

16 Bit Color, 800x600 Display

Browser:
« Internet Explorer 4 (or above), ActiveX Plug-Ins Enabled, Scripts Marked Safe Enabled, or
Netscape Communicator 4.x or 6.1 (or above), JavaScript Enabled

Plug-Ins:
» Macromedia Shockwave 8.0 (or above)

Bandwidth:
« Average of 36 Kilobits/sec per User

For more information, to request a free trial, or to place an order:
Call 1-800-366-4614
E-Mail sales@teknimedia.com
Visit our web site at www.teknimedia.com

Teknimedia Corporation 1-800-366-4614

4905 Del Ray Ave., Suite 307 www.teknimedia.com
Bethesda, MD 20814 info@teknimedia.com




